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ABSTRACT 

 

The project objectives are to ensure that the simulation results are valid by comparison 
with the Standard Series Data and compare the performance of propeller with and 
without fins, based on Computational Fluid Dynamics (CFD) analysis. The propeller is 
based on Wageningen B3.55 series and made from aluminium alloy. Theoretically the 
fins on the back side of propeller blade will increase the thrust produce by the propeller. 
The methodology of this project can be divide to three parts depends on the software 
used; PolyWorks, SolidWorks and CosmosFloWorks. The propeller is divided into two, 
with and without fins. A propeller with two fins in the format of PolyWorks file after 
the propeller had through 3D scan process is provided, thus further 3D modeling 
process using PolyWorks had to be made. Other than to process the propeller to desired 
shape, 3D modeling also used to smoothen the surface, eliminate any defects like hole 
and gaps on the surface of propeller. SolidWorks is important software in this project 
not only because it can read the IGES file format from PolyWorks, also 
CosmosFloWorks is the plug-in for SolidWorks. The function of CosmosFloWorks is to 
analyze the performance of propellers where the value of thrust and torque is taken. 
Thrust is the force produced at a given speed when propeller rotates and torque is the 
moment act on the propeller blades. The value of thrust and torque from Standard Series 
Data and analysis of propeller without fins is compared to make sure the data from 
analysis is valid. It is observed that the value of thrust from Standard Series Data is 
higher than the thrust value from propeller without fins around 4.3% and 2.6% for 
torque. The velocity of boat is set from 3 knots to 7 knots and the slippage is not 
considered in the analysis. The average increase of thrust by the propeller with fins 
compare to propeller without fins is around 9.1% and 4.4% for torque value. 
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ABSTRAK 

 

Objektif projek ini adalah untuk memastikan keputusan daripada simulasi adalah sah 
melalui perbandingan antara ‘Standard Series Data’ dan prestasi kincir tanpa sirip 
berdasarkan kaedah analisis ‘Computational Fluid Dynamics (CFD)’. Kincir yang 
digunakan dalam projek ini adalah berdasarkan siri model Wageningen B3.55 dan 
dibuat daripada aloi aluminium. Secara teori, sirip di permukaan belakang kincir akan 
menambahkan penghasilan jumlah daya oleh kincir. Metodologi projek ini dibahagikan 
kepada tiga bahagian bergantung kepada perisian yang digunakan; PolyWorks, 
SolidWorks and CosmosFloWorks. Kincir akan dibahagikan kepada dua iaitu dengan 
sirip dan tanpa sirip. Kincir dengan sirip diperolehi selepas daripada proses ‘3D scan’, 
oleh itu proses permodelan 3D lebih lanjut harus dilakukan menggunakan PolyWorks. 
Selain daripada mengubah model ke bentuk yang dikehendaki, proses permodelan 3D 
juga digunakan untuk meratakan permukaan, menghapuskan sebarang kecacatan seperti 
lubang-lubang dan ruang-ruang pada permukaan kincir. SolidWorks adalah perisian 
yang penting bukan sahaja kerana ia dapat membaca file IGES daripada PolyWorks, 
malah CosmosFloWorks juga adalah plug-in kepada SolidWorks. Fungsi 
CosmosFloWorks adalah menganalisa prestasi kincir yang mana nilai daya tujahan dan 
tork yang dihasilkan dikira. Daya tujahan adalah daya yang dihasilkan oleh apabila 
kincir berputar pada kelajuan yang ditetapkan dan tork adalah daya putaran yang 
bertindak pada bilah kincir. Nilai daya tujahan dan tork daripada ‘Standard Series Data’ 
dibandingkan dengan nilai tersebut daripada analisis untuk memastikan keputusan 
daripada analisis boleh diterima. Dapat diperhatikan bahawa jumlah daya tujahan  
daripada ‘Standard Series Data’ adalah lebih tinggi daripada analisis sekitar sebanyak 
4.3% dan 2.6% untuk tork. Halaju boat dalam projek adalah ditetapkan dari 3 knot ke 7 
knot dan nilai gelinciran oleh kincir tidak diambil kira dalam analisis. Kincir dengan 
sirip meningkatkan daya tujahan sebanyak sekitar 9.1% dan tork sekitar 4.4% lebih 
tinggi daripada kincir tanpa sirip. 
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CHAPTER 1 

 

 

INTRODUCTION 

 

 

1.1       INTRODUCTION 

 

Ship propulsion at the required sea speed occurs with the help of a propulsion 

device. The most common propulsor is the propeller, which converts engine torque to 

ship thrust, accelerating the fluid in which it works. The propeller plays an important 

role in the interaction between ship, engine and propulsor. Conventional propellers are 

mounted on a shaft and operate behind ship’s hull. 

 

Actually the propulsion of propeller is a very complex process that include 

knowledge in fluid dynamics, physics, metallurgy, naval architecture, mechanical and 

marine engineering. A lot of considerations has to be made and calculated using various 

theories such as momentum theory, blade element theory and thin aerofoil theory. 

However as the technology develop, new and easier analysis of performance of 

propeller can be made by using Computational Fluid Dynamics (CFD) analysis method. 
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1.2 PROBLEM STATEMENTS 

 

Today, conventional marine propellers remain the standard propulsion 

mechanism for surface ships and underwater vehicles. The performance of the propeller 

is depend on various factors including their geometry and dimensions. Small changes of 

geometry would reasonably affecting the performance by decrease or increase the value 

of torque and thrust of propeller.  

 

 Existing propeller produce thrust and torque to enable the boat to move. 

However, the conventional design of propeller did not produce enough thrust. 

Therefore, new design needs to be produce such as the additional fins at the blades. 

 

1.3 OBJECTIVES OF THE PROJECT 

 

The main objective of this project is to conduct the computational fluid dynamic 

analysis of propeller. The overall objectives are: 

   

i. To ensure that the simulation results is valid by comparison with the Standard 

Series Data. 

ii. To compare and investigate the performance of propeller with and without fins. 

 

1.4 SCOPE OF STUDY 

 

This project concentrates on the performance of the propeller when attached 

with fins. The scopes of study are as follows: 

 

(i) 3D modeling using PolyWorks 

(ii) Computational fluid dynamics analysis using SolidWorks and 

CosmosFloWorks. 
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1.5 OVERVIEW OF THE REPORT 

 

Chapter 1 gives the brief the content and background of the project. The 

problem statement, scope of study and objectives are also discussed in this chapter. 

 

Chapter 2 discuss about the basic nomenclature of propeller in terms of 

performance, types, performance characteristics and failure of marine propellers. Also 

definition of Computational Fluid Dynamics (CFD) analysis and software used in this 

project elaborated in this chapter. 

 

Chapter 3 presents the flowchart, 3D modeling process and analysis operation 

involve in this project.  

 

Chapter 4 explaining the result obtains from chapter 3 and discussion. This is 

including data presentations using graph, flow trajectories and others. 

 

Chapter 5 presents the conclusions of the project. Suggestions and 

recommendations for the future work are put forward in this chapter. 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

CHAPTER 2 

 

 

LITERATURE REVIEW 

 

 

2.1 INTRODUCTION 

 

The purpose of this chapter is to provide a review of the marine propeller, 

definition of Computational Fluid Dynamics (CFD) analysis, performance 

characteristics of propeller, software involve in this project and the background of 

propeller with invention. The review is fairly detailed so that the present research effort 

can be properly modified to add to the present body of literature as well as to justify the 

scope and direction of present research effort. 
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2.2 REVIEW OF PROPELLER 

 

2.2.1 Basic Nomenclatures of Propeller in Terms of Performance. 

 

Diameter 

 

Diameter is crucial geometric parameters in determining the amount of power 

that a propeller can absorb and deliver, thus determining the thrust available for 

propulsion. Usually the diameter is proportional to the efficiency of propeller, but in 

high speed vessels larger diameters equates high drag. For typical vessels a small 

increase in diameter translates into a dramatic increase in thrust and torque load on the 

engine shaft, thus the larger the diameter the slower the propeller will turn, limited by 

structural loading and engine rating. 

 

 
Figure 2.1: Diameter of propeller 

 

Pitch  

 

Pitch is the theoretical distance travel in one revolution of propeller. For 

example, the propeller move 10 inches in one revolution, thus the nominal pitch of the 

propeller is 10 inches. It is called nominal pitch because the actual pitch of propeller 

will be less than the nominal pitch. The difference between nominal and actual pitch is 

called slip.  
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Slip is the difference between actual and theoretical travel of the propeller blades 

through water. A properly matched propeller will actually move forward about 80 to 90 

percent of the theoretical pitch. The ratio of pitch to diameter (P/D) is typically falls 

between 0.5 and 2.5 with an optimal value for most vessels closer to 0.8 to 1.8. Pitch 

effectively converts torque of the propeller shaft to thrust by deflecting or accelerating 

the water astern – simple Newton’s Second Law. 

 

 
 

Figure 2.2: An example of propeller with 21 inches pitch 

 

 

 
 

Figure 2.3: Illustration of the slip on propeller 

 

Hub  

 

Solid centre disk that mates with the propeller shaft and blades. Ideally the hub 

should be as small in diameter as possible to obtain maximum thrust, however there is a 

tradeoff between size and strength. Too small a hub ultimately will not be strong 

enough. 
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Blade 

 

Blades are the twisted fins or foils that protrude from the propeller hub. The 

shape of the blades and the speed at which they are driven dictates the torque a given 

propeller can deliver. Blade root is where the blade attached to the hub, and blade tip is 

the outermost edge of blade at a point furthest from the propeller shaft. 

 

High pressure side of blade is called blade face. This is the side that faces aft 

(backward) and pushes the vessels in forward motion. The back of the blade is the low 

pressure side or the suction face of the blade. This is the side that faces upstream or 

towards the front of the vessel. 

 

Number of blades 

 

The number of blades will critically dictate the performance of a propeller. 

Basically greater speed, horsepower and load requirements of vessel need propeller with 

more blades. In design consideration, the number of blades is primarily determined by 

the need to avoid harmful resonant frequencies of the ship structure and machinery. It 

also found that both propeller efficiency and optimum propeller diameter increase as 

blade number decrease.  

 

 With increased number of blades the surface area increases which reduces the 

slip in cruising speeds. Increased number of blades also gives a smoother behavior of 

the vessel with greater control in turns and in rough waters. Four and five blade 

propeller are also reducing vibrations and noise due to a better balance and are causing 

less wear on the transmission system. Adding blades however often decreases top speed 

with a couple of knots, but this is a trade-off in the propeller selection process. The 

propeller in this project has three blades. 
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2.2.2 Type of Propellers 

 

The type of propeller and their characteristics are discussed in table below: 

 

Table 2.1: Type of propeller and their characteristic 

 

Propeller Type Characteristics 

Fixed pitch propellers Ease of manufacturer 

Design for single condition 

Blade root dictates boss length 

No restriction on blade area or shape 

Rotational speed varies with power absorbed 

Relatively for small vessels 

Controllable pitch 

propellers 

Can accommodate multiple operating conditions 

Constant or variable shaft speed operation 

Increased mechanical complexity 

Larger hub size 

Ducted propellers Can accommodate fixed and controllable pitch propellers 

Enhanced thrust at low ship speed 

Duct form can be either accelerating or decelerating 

Azimuthing units Good directional control of thrust  

Increase mechanical complexity 

Can employ either ducted or non-ducted propellers of either 

fixed or controllable pitch type 

Cycloidal propellers Good directional of thrust 

Avoids need for rudder on vessel 

Increase mechanical complexity 

Contra-rotating 

propellers 

Enhanced propulsive efficiency in appropriate conditions 

Increased mechanical complexity 

 

Source: Carlton, J. 2007. Marine Propellers and Propulsion Second Edition. 

 

The propeller used in this project is type fixed-pitch propeller. 
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2.2.3 Material of Propellers 

 

The materials from which propellers are made today can broadly be classed as 

members of the bronzes or stainless steels. The once popular of cast iron has now 

virtually disappeared, even for the production of spare propellers, in favor of materials 

with better mechanical and cavitation resistant properties. The propeller in this project is 

made from aluminium alloy.  

 

The properties required in a propeller material will depend to a very large extent 

on the duty and service conditions of the vessel to which propeller are being fitted. 

However, the most desirable set of properties which it should posses as follows: 

 

(i) High corrosion fatigue resistance in water 

(ii) High resistance to cavitation erosion 

(iii)Good resistance to general corrosion 

(iv) High strength to weight ratio 

(v) Good repair characteristics including weldability and freedom from 

subsequent cracking 

(vi) Good casting characteristics 
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2.3 PROPELLER PERFORMANCE CHARACTERISTICS 

 

The performance of propellers are mostly depends on the thrust produced. 

Thrust is a force that driven the propeller forward. Actually the details on how a 

propeller generates thrust are very complex. A lot of consideration must be made 

including the wake field, temperature, water density and others. However it still can be 

elaborated using simplified momentum theory. 

 

Simple momentum theory state that the thrust of a propeller depends on the 

volume of fluid accelerated per time unit, fluid acceleration and density of medium. The 

formula based on momentum theory expressed by equation (2.1) below. 

 

𝑇 =  𝜋 4� .𝐷2. �𝑣 +  Δ𝜐 2� �.𝜌. Δ𝜐 

 

Where:  

 

 

 

 

 

Examining this quite simple formula reveals that the thrust, T increases when the 

diameter, D increases or when the density, ρ of the medium increases. The acceleration, 

∆v of a propeller depends on the velocity, v, thus it is generally not true that increasing 

the velocity increases the thrust. But it can be said, that increasing the additional 

velocity increases the thrust.  

 

The performance characteristics of a marine propeller can be divided into two; 

open water and behind-hull properties. Open water characteristics relate to the 

description of the forces and moments acting on the propeller when operating in a 

uniform fluid stream. Behind-hull properties are performance of propeller in a mixed 

wake field behind a body, thus more complex and closer to actual performance. 

However we only discussing open water characteristics since these form basic 

performance parameter of propellers. 

T Thrust  

D Diameter 

V Velocity of incoming flow 

∆𝜐 Additional velocity accelerated by propeller 

 Density of fluid (water:  = 1000kg/m3) 

(2.1) 
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The forces and moments produced by the propeller are expressed in their most 

fundamental form in terms of a series of non-dimensional characteristics. The terms 

used to express general performance of propeller are as follows: 

 

Thrust coefficient: 𝐾𝑇 =  𝑇 𝜌𝑛2𝐷4�  

Torque coefficient: 𝐾𝑄 =  𝑄 𝜌𝑛2𝐷4�  

    Advance coefficient:          

 

Where:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

T Thrust 

Q Torque  

D Diameter  

 Density of fluid 

n Rotational speed 

Va Speed of advance 

(2.2) 

(2.3) 

(2.4) 
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2.4 DEFINITION OF CFD ANALYSIS AND SOFTWARE USED  

 

2.4.1 Computational Fluid Dynamic (CFD) 

 

Computational Fluid Dynamic (CFD) is a branch of fluid mechanics that uses 

numerical methods and algorithm to solve and analyze problem that involve fluid flows. 

Computers are used to perform the millions of calculations required to simulate the 

interaction of liquids and gases with surfaces defined by boundary conditions. Even 

with high-speed supercomputers only approximate solutions can be achieved in many 

cases. Ongoing research, however, may yield software that improves the accuracy and 

speed of complex simulation scenarios such as transonic or turbulent flows.  

 

CFD is now recognized to be a part of the computer-aided engineering (CAE) 

spectrum of tools used extensively today in all industries, and its approach to 

modeling fluid flow phenomena allows equipment designers and technical analysts to 

have the power of a virtual wind tunnel on their desktop computer. CFD has become an 

indispensable part of the aerodynamic and hydrodynamic design process for planes, 

trains, automobiles, rockets, ships, submarines; and indeed any moving craft or 

manufacturing process that mankind has devised. 

 

2.4.2 PolyWorks 10.0 

 

PolyWorks version 10.0 is developed by InnovMetric Software Inc. InnovMetric 

was founded in 1994 and pioneered the market for point cloud inspection and reverse 

engineering software solutions. InnovMetric is a privately owned company that enjoys 

an enviable position as the market leader in point cloud processing software in the 

automotive and aeronautic industries. 

 

PolyWorks is a complete point cloud processing software solution which 

comprises of two packages; PolyWorks Inspector and PolyWorks Modeler. In this 

project, PolyWorks Modeler is used because it is a reverse-engineering module that 

produces highly accurate polygonal models and NURBS surfaces that are exportable to 

any CAD/CAM/CFD/FEA software for stringent manufacturing applications. 
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2.4.3 SolidWorks 2008 

 

SolidWorks is developed by Dassault Systèmes SolidWorks Corp that was 

founded in December 1993 and headquarters at Concord, Massachusetts, USA. In this 

project, SolidWorks 2008 was use as the platform to analyze the propeller because 

CosmosFloWorks is the ads-in for SolidWorks. The IGES file from Polyworks needs to 

be open using SolidWorks before the analysis can start. Other than that, SolidWorks 

also can check the geometry error at the propeller model and repaired it. If the model 

had defects like hole, layer and others, no analysis can be made by CosmosFloWorks. 

 

2.4.4 CosmosFloWorks  

 

CosmosFloWorks is the first easy-to-use fluid flow simulation and thermal 

analysis program that is fully embedded inside SolidWorks. CosmosFloWorks can 

analyze a wide range of real fluids such as air, water, gasses, plastic melts and other 

more which makes it ideal for engineers in nearly every industry.  

 

Table 2.2: Some analyze operation by CosmosFloWorks 

 

Type of fluid flow Operations available 

Internal flow Flow of liquids and gases through valves, regulators and ducts. 

External flow Flow of liquids and gases around solid bodies like flow of air 

over an airplane or flow of water around a submarine. 

Transient flow Simulate unsteady flow over a short period of time. 

Turbulent flow K-E model to understand turbulence in the flow domain, for 

example, the flow of gases from an aircraft engine nozzle. 

Compressible flow Analyze gas flows in subsonic, transonic, and supersonic speed 

zones like flow around an aircraft engine moving at the speed of 

Mach 1.  

 

Source: CosmosFloWorks Overview, 2008. 
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 2.5 INVENTIONS OF PROPELLER WITH FINS 

 

2.5.1 Introduction 

 

 The propeller with fins is a simple but yet effective idea by Ir. Suryo Widodo 

Adji in enhancing the performance of propeller without any major changes to the engine 

and gearing system. He is the head lecturer of Marine Engineering Sepuluh Nopember 

Institute of Technology (ITS) – Surabaya, Indonesia. This propeller is called Adjie 

Propeller and it had been patented and commercialize.  

 

 The propeller with fins is suitable to use with small wood ships for fisherman 

and fiberglass ships with outboard engine. It can increase the velocity of ship by 15% to 

19% faster and also better acceleration. It had been tested using small fisherman 

wooden ships and the result was very encouraging. The ship can achieve 5 to 6 knots 

when using propeller with fins and only 4 to 5 knots if using propeller without fins.  

 

This propeller is based on Wageningen B screw series with three blades and 

blade area ratio of 0.55. It is made from aluminium alloy and comes with three different 

diameters; 8 inches, 10 inches and 12 inches.  
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2.5.2 The Dimensions of Fins 

 

 There are several conditions must be fill in designation of propeller fins to 

achieve optimum performance and required goals. Two fins attached to the back side of 

propeller blade in parallel position and it is called upper and lower fins. The figure 2.4 

is the description if propeller with fins from Teknik Sistem Perkapalan, FTK-ITS 

(2009). It shows us the position of fins and other dimensions of propeller. 

 

 
Figure 2.4: Illustration of the propeller dimensions  

 

 The shape of fins is actually like an aerofoil where the sharp part is towards the 

leading edge of propeller. The length of upper fins is longer than lower fins by 40% and 

maximum height of fins is 14% from overall length of fins. The position of fins is 

depends on two parameters; the radius of propeller and the ratio of inlet and outlet of 

flow through the fins. The inlet and outlet is illustrated by number 2 and 6 in the figure 

above. The fins are positioned from 30% to 80% of the propeller radius. Maximum 

thickness of fins is situated 60% to 90% of fins length from the trailing edge. There are 

others dimensions and considerations made in this design but it is protected by the 

patent law and undisclosed from public.  

Legends: 

1. Blade of propeller 
2. Inlet flow 
3. Upper fin 
4. Lower fin 
5. Back side of propeller  
    blade 
6. Outlet flow 
7. Leading edge 
8. Trailing edge 
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2.5.3 The Concept of Propeller with Fins 

 

The purpose of the invention of propeller with fins is to maximize the thrust 

produce by the propeller without any changes on the engine of the boat. With this extra 

thrust, the boat will cruise faster and have better acceleration.  

  

 The concept of this invention is by decreasing the pressure on the back face side 

of propeller, thus enhancing the pressure difference between the back and front side of 

propeller compare to conventional propeller. The method used to achieve this objective 

is by using two fins that is attached on the back face side of the propeller blade. These 

fins will accelerate the fluid flow velocity and make the flow more uniform, hence 

increase the lift force act on the blade of propeller. 

 

Law of Bernoulli states that this higher velocity will decrease the pressure on the 

back side of propeller blade. Then according to blade element theory, higher pressure 

different will yielded higher thrust. Below is an illustration in explaining the pressure on 

the blade according to blade element theory. 

 
Figure 2.5: Illustrations of the pressure act on the surface of blade 

 

Source: http://marinoos.blogspot.com (2007) 

http://bp1.blogger.com/_D5jUwlh7l_Q/RwAM07RIwoI/AAAAAAAAABA/_S4UVra5zOU/s1600-h/FOIL.b
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 The first illustration show us the pressure exerted on the surface of blade without 

fins. When arrive on the leading edge, the fluid flow with velocity of Va divide into two 

surface, back and front side of propeller blades. The back side has higher velocity and 

thus the pressure become lower. The front side has lower velocity and thus the pressure 

is higher. Lift force created towards the back side of the propeller. 

 

 The second illustration show us the pressure exerted on the surface of blade 

when the fins attached by assuming same inlet flow velocity, Va. Note that the velocity 

flows on the front side remain same as before. However on the back side where the fins 

attached, the flow become higher compare to the propeller without fins. Water at 

leading edge has wider path and gradually the path become narrower towards the 

trailing edge. Higher pressure difference on blade will increase the lift force on the 

blade as well as the thrust produce. Also the velocity of flow after it had passed the 

propeller is higher compare to propeller without fins.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

CHAPTER 3 

 

 

METHODOLOGY 

 

 

3.1 INTRODUCTION 

 

This chapter will explain the overall methodology involve in this project. Before 

the project start, good understandings in propulsions of propeller are essential. The 

basic parts and nomenclature of propeller in terms of propulsion performance had been 

discussed in the literature review chapter. In addition, understanding the software used 

is primary importance to make sure better analysis operation and furthermore increase 

the accuracy of the result. 

 

Generally this project involves 3D modeling, analysis and comparing the result 

of analysis. 
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Figure 3.1: Flowchart of the project  
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3.2 3D MODELING 

 

The supervisor had prepared the 3D model of the propeller using 3D scanner 

before the project can start. In this step, software named PolyWorks version 10.0 had 

been used. Using PolyWorks, the 3D model are repaired, reconstructed and edited to 

fulfill the objectives of this project. The model must be repaired because there are a lot 

of defects on the surface like holes, layer and rough surface due to the sensitiveness of 

3D scanner. If the surface did not repaired, the model can still converted to iges (.IGES) 

format but cannot analyze using CosmosFloWorks.  

 

3.2.1 Hole Filling 

  

Figure below is an example a hole on the surface of propeller: 

 

 
 

Figure 3.2: A sample of hole on the surface of propeller model  

 

PolyWorks offers a tool for filling holes interactively. This tool automatically 

detects hole boundaries on the model and offers an interactive mode for selecting the 

boundaries of the holes to clean and/or fill. 

 

To invoke the operation, select the Click & Fill Holes item [Model > Triangles 

(Advanced)], or press the “Fill holes in one mouse click” button in the Advanced 

Triangle Creation and Editing section of the Polygonal Edition toolbar. 
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Figure 3.3: Dialog box for ‘Click & Fill Holes’ process  

 

The hole will automatically fill: 

 

 
 

Figure 3.4: Surface of propeller after the hole was filled 
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3.2.2 Mesh Reconstruction 

 

Other than filling the hole, PolyWorks also provides a tool for automatically 

reconstructing selected areas of a model with a smooth surface following the local 

geometry of the part. Area of interest is selected, then select the Reconstruct item 

[Model > Triangles (Advanced)], or press the corresponding “Reconstruct Mesh” button 

in the Advanced Triangle Creation and Editing section of the Polygonal Edition toolbar. 

This area will automatically be constructed.  

 

 
 

Figure 3.5: Illustration of reconstruction operation  

 

 

3.2.3 Editing Model 

 

The models of propeller are divided into two: 

 

(i) Propeller with fins 

(ii) Propeller without fin 

 

The default 3D model of propeller has two fins. Thus to achieve these goals, the 

model is edited to eliminate fins as well as maintaining its original geometry. This step 

needs to be done carefully because any defects even a very small hole or layer can 

disturb the surface produced. For example, steps taken to eliminate one fin is summarize 

like below: 

 

(i) Select the fin as well as the surface around the fin. 
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Figure 3.6: The area with red color was the selected area for this operation 

 

(ii) Then delete the fin. 

 

 
 

Figure 3.7: Surface of propeller after the area of interest is deleted  

 

The result was a hole. At this time, we cannot use ‘Click & Fill Holes’ 

option yet because there are many particles of surfaces that is not fully 

deleted. If these particles did not eliminate, it will cause geometry errors. 

From closer view and different angle, we can see these particles better: 
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Figure 3.8: Picture of particles on the surface of propeller from closer and different 

view  

 

These steps are repeated until the desired model did not have any defects or 

particles before proceed to create curve network. 

 

3.2.4 Creating Curve Network 

 

A curve network is built from a set of magnetized curves. Each magnetized 

point forms a node in a curve network. The curve must continues, belong to only one 

polygonal model and cannot be associated to more than two patches. Invalid patches 

will result in holes in the curve network. 

 

PolyWorks offers automatic surfacing capabilities. The algorithm analyzes the 

curvature of the polygonal surface and tracks the natural lines of curvature, and 

automatically lays down a network of curves on selected triangles of a polygonal model. 

We need to select the Create Automatically from Model item [Edit > Curve Network], 

or press the corresponding button in the Curve Network Creation section of the Main 

Objects tool-box. 
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Figure 3.9: Dialog box for ‘Curve Network From Model’  

 

This dialog box offering several items that control the creation of the automatic 

Curve Network: 

 

(i) Roughness of polygonal model: 

 

A combo box that guide the algorithm by qualifying the roughness of the surface 

of the polygonal model subjectively as low, medium, or high. This parameter is 

used when the Curvature evaluation radius parameter in the Advanced section of 

the dialog box, is set to Automatic. 

 

(ii) Curve-to-mesh tolerance 

 

A text box that defines a tolerance between the created curves and the polygonal 

mesh. 

 

(iii)Use selected curves 

 

A check box that, when enabled, specifies that selected Curves will be 

magnetized and networked to automatic curves. 
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3.2.5 Creating NURBS Surfaces 

 

To invoke this operation, select the Curve Network objects and then select the 

Fit NURBS Surfaces item [Edit > Curve Network], or press the corresponding button in 

the Curve Network Editing section of the Main Objects toolbar.  

 

 
 

Figure 3.10: Dialog box for ‘Fit Networks NURBS Surfaces’ 

 

This dialog box offering several items that control the creation of the automatic Curve 

Network such as: 

 

(i) Max projection distance 

 

Boundary control points within this distance are projected onto the polygonal 

mesh. 

 

(ii) # of control points on boundaries 

 

Defines the number of control points for the boundary curves that make up each 

NURBS surface. The default value is 5. It is not recommended to use a value 

smaller than this.  
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3.3 CONVERT NURBS SURFACES TO IGES FILE 

 

To automatically convert NURBS surfaces to IGES file, click File > Export 

Objects > Curve Network NURBS Surfaces to IGES. We can choose six different units 

of IGES; milimter, centimeter, feet, inch, meter and micron. These IGES file then 

opened using SolidWorks and SolidWorks will request us to save the model as 

SolidWorks file (.sldprt). We have to accept this request because CosmosFloWorks 

cannot analyze IGES file. According to objectives of the project, there are two types of 

3D model. The snapshots of these models in SolidWorks file format are shown below: 

 

 
 

Figure 3.11: Isometric, front and rear view of propeller with two fins 

 

 
 

Figure 3.12: Isometric, front rear view of propeller without fins 
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3. 4 CHECK FOR GEOMETRY ERROR 

 

In SolidWorks, we must use ‘Import Diagnostics’ option to analyze, repair and 

heal the faulty faces and gapes between faces. This step is really important to make sure 

the model of propeller did not have any geometry errors. CosmosFloWorks cannot be 

executed if there are any small error like faulty faces and gapes between edges of 

surface.  

 

Under ‘Evaluate’ section, choose ‘Import Diagnostics’ and right click at the list 

of faulty faces, then click ‘Repair Face’. The same instruction for ‘Gaps between faces’ 

or just click ‘Attempt to Heal All’ for automatic repair operation for all faulty faces and 

gapes. The example of dialog box shown below: 

 

 

Figure 3.13: Dialog box for ‘Import Diagnostics’ 
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However not all geometry error can be heal and repair by SolidWorks. If this 

happen, we have to recheck the 3D modeling process that we had done to the propeller. 

Another process of 3D modeling including mesh reconstruction, polygonal editing, 

creating curve network and NURBS surfacing need to be done again. This process is 

repeated until 3D model without geometry error and ready for analysis operation 

produced.  

 

3.5 SET THE BOUNDARY CONDITIONS 

 

After all the geometry error repaired, then we are ready for analysis operation 

using CosmosFloWorks. In the General Settings box, we can set analysis type, rotation 

analysis, fluids, wall conditions and initial and ambient conditions. 

 

 
 

Figure 3.14: Dialog box for ‘General Settings’ in choosing the type of analysis and 

rotation 
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3.5.1 Analysis Type 

 

There are two types of analysis under CosmosFloWorks; internal and external. 

For this project, we use external analysis because flow analysis concerns flows not 

bounded by outer solid surfaces, but only by the computational domain boundaries. In 

this case the solid model is fully surrounded by the flow.  

 

3.5.2 Rotation Type 

 

There are also two types of rotation; local region(s) and global rotating. Local 

region is the best rotation type for this project. Through local region rotation, we can 

specify the local rotating reference frame(s). This allows us to analyze the fluid flow 

through rotating components of the model. In order to specify the local Rotating region 

we need to create a component representing it.  

 

The fluid flow within the rotating region is calculated in the rotating region’s 

local reference frame. Flow field parameters are transferred from adjacent flow regions 

to the rotating region’s boundary as boundary conditions. The flow field must be axially 

symmetric at the rotating region’s boundary and the rotating regions not intersect with 

each other. The reference axis was axis-Z. 

 

3.5.3 Fluids 

 

In fluids section, we choose water as the project fluids. Note that wall 

conditions, initial and ambient conditions are set to default. 
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Figure 3.15: Dialog box for ‘General Settings’ in choosing the project fluids 

 

3.5.4 Creating Rotating Region 

 

Creating rotating region was one of the trickiest parts in this project. First, 

another simple cylinder shape of polygonal model designed like below: 

 

 
 

Figure 3.16: Simple cylinder shape of polygonal model as the rotating region 

 

The propeller must fit and enclose in this cylinder model, thus they have same 

diameter. Their diameter is 217 mm. Also we have to make sure the axis of revolution 

for cylinder model must coincide with the rotation axis.  
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Figure 3.17: Arrangement of circle and propeller model from isometric view 

 

The reason why this circle shape model made is because it will become the basis 

of the rotating region. The center of this circle will become the center of rotation, so we 

have to make sure that the center of the circle must coincide with the center of propeller. 

Before we can set it as the rotating region, it must disabled in the component control. At 

the toolbar, select FloWorks > Component Control > Click the Circle model > Disable 

> Ok. The purpose of this step is to set this region as the rotating fluid region and did 

not involve in the analysis.  

 

Then to set this circle model as the rotating region, right click ‘Rotating 

Regions’ in the Cosmos FloWorks Analysis tree and select ‘Insert Rotating Region’ 

then select this circle model. 

 

 
 

Figure 3.18: Dialog box for ‘Rotating Region’ 
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Note that in this dialog box, we can set the rotational speed of propeller and the 

direction of rotation. The direction of rotation is simply the annotation of the rotational 

speed value. For example if the rotation value was 400 rad/s, the propeller will rotate 

400 rad/s clockwise. Thus the propeller will rotate counter-clockwise if the value of 

rotation was -400 rad/s. In this project, the propeller had clockwise rotation. 

 

3.5.5 Set the Computational Domain 

 

All the components involve must positioned in the computational domain area. 

 

 
 

Figure 3.19: Dialog box for ‘Computational Domain’ 

 

 
 

Figure 3.20: Isometric view of computational domain area 
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3.5.6 Set the Calculation Operations 

 

Right click input data at the FloWorks analysis tree and select Calculation 

Control Operations. Minimum refinement number is set to 0 and maximum iteration is 

set to 2000. Clear the maximum calculation time, maximum travels, and goal 

convergence check box 

 

 
 

Figure 3.21: Snapshot of ‘Calculation Control Options’ dialog box 

 

3.5.7  Set the Force Engineering Goal 

 

 At the FloWorks analysis tree, right click at Goal and select Insert Global Goals. 

Then tick Z – component of force and Z – component of torque to measure force/thrust 

and torque of propeller. 
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3.6 DATA ANALYSIS 

 

 After all the boundary conditions has been set, we can proceed to the most 

important part of the project; data analysis. To start the analysis, select Run and set the 

Run dialog as shown in Figure 3.22 below. Make sure to click the New Calculation and 

Solver tab before proceed. 

 

 
 

Figure 3.22: The dialog box to start the analysis by CosmosFloWorks 

 

 There are many ways to represent the result of analysis using CosmosFloWorks 

2008. However, the suitable result presentations are cut plots, surface plots, flow 

trajectories and animations. 

 

 

 

 

 

 

 

 

 



 

 

 

CHAPTER 4 

 

 

RESULT AND DISCUSSION 

 

 

4.1 INTRODUCTION 

 

This chapter will explain the result from the analysis. The value of thrust and 

torque is used to compare the performance between propellers. These values are 

obtained by simply set the Z-component of force as the thrust and Z-component of 

torque as the torque from Global Goal options in CosmosFloWorks 2008.  

 

 Options had been made while using CosmosFloWorks 2008 including the 

environment conditions and slippage of propeller. In actual condition, the actual value 

of pitch is less than the nominal pitch because of the slippage. However in 

CosmosFloWorks 2008, the slip value is not considered in analysis process because 

there are no options for slippages deficiency. Also we neglect the effect of hull’s shape 

to the flow of fluid. We assume that the fluid is in static condition before the propeller 

accelerates them.  

 

 The propeller with fins is used for small wooden fisherman ships and fiberglass 

ships with outboard engine. The velocity of the small wooden fisherman ship would 

achieve 5 knots when using this propeller and only around 4 knots if using the propeller 

without fins. Thus for this project, we assume the velocity of ships is from 3 knots to 7 

knots. By assuming there are no slips occur, the velocity is converted to rotational speed 

to use in the analysis process. 
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4.2 THRUST AND TORQUE VALUE FROM STANDARD SERIES DATA 

 

 The propeller without fins is based on Wageningen B3.55 model. B3 means it is 

B model with 3 blades while 55 means it has blade area ratio of 0.55. Using the standard 

series data of Wageningen B from Appendix B and manipulation of the formulas 2.2 to 

2.4, we can predict the value of thrust and torque of this propeller. Note that we assume 

the propeller did not have slips and the pitch value is 0.23 meter. 

 

 The first step to find the thrust and torque value is by calculating the advance 

coefficient, J. This value is inserted in the diagram from reference 2 and based on the 

pitch ratio, we can find the value of thrust coefficient, KT and torque coefficient, KQ. 

These values then inserted into equations 2.2 and 2.3 to find the thrust and torque value. 

Pitch ratio is the propeller pitch divide by the diameter. The table below shows us the 

value of thrust and torque of propeller from standard series data. 

 

Table 4.1: Thrust and torque value from standard series data 

 

Velocity, 

Knots 
Thrust, N Torque, Nm 

3 373.20 13.51 

4 663.46 24.02 

5 1036.66 37.53 

6 1492.79 54.04 

7 2031.85 73.55 
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4.3 THRUST AND TORQUE VALUE FROM ANALYSIS 

 

4.3.1 Propeller Thrust 

 

Table 4.2 below is the comparison between the value of thrust from Standard 

Series Data and the analysis of propeller without fins. Theoretically, the value of thrust 

from Standard Series data should same as the value of thrust from propeller without fin. 

It is observe that the value of thrust from Standard Series Data is higher than the thrust 

value from propeller without fins around 4.3%. It is less than 5%, thus the value of 

thrust from analysis is valid for this project. 

 

Table 4.2: Comparison of thrust from Standard Series Data  

against propeller without fins 

 

Velocity, 

Knots 

Thrust from Standard 

Series data, N 

Thrust for propeller 

without fins, N 

Percent 

error, % 

3 373.2 357.6 4.4 

4 663.5 640.8 3.6 

5 1036.7 991.4 4.6 

6 1492.8 1433.7 4.1 

7 2031.9 1940.9 4.7 

  Average 4.3 

 

Thrust is the force produced at a given speed when propeller rotates. Based on 

equation 2.2, the thrust increase as the rotational speed increase. From the analysis, it is 

observed that uniform slopes are produce where the values of thrust for all propellers 

increase gradually. Based on figure 4.1, the thrust is almost identical for both propellers 

at lower velocity from 3 to 4 knots. Their differences then increase from 4 knots to 7 

knots. Overall, the propeller with fins is better than the propeller without fins in terms of 

thrust. 
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Figure 4.1: Graph of thrust versus rotational speed 

   

According to Dr Widodo Adji (2009), the propeller with fins can make the boat 

faster for about 15% to 19% compare to boat with propeller without fins. Table below 

shows us the percent increase of the thrust value when the propeller attached with fins. 

Based on table 4.3, the percent increase of thrust are not uniform because their range is 

from 6.76% to 9.8%. The lowest increase of thrust value is at 4 knots with only 6.76%, 

while the highest is at 3 and 7 knots with 9.8% increase. The average of increase is 

around 9.1%. 

 

 

 

 



40 
 

Table 4.3: Comparison of thrust value from propeller with and without fins 

 

Velocity, 

Knots 

Thrust for propeller 

without fins, N 

Thrust for propeller 

with fins, N 

Percent 

increase, 

% 

3 357.6 392.6 9.8 

4 640.8 684.1 6.8 

5 991.4 1083.6 9.3 

6 1433.7 1569.4 9.5 

7 1940.9 2131.7 9.8 

  Average 9.1 
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4.3.2 Propeller Torque 

 

 Same steps are used for the torque value. The value of torque from Standard 

Series Data and the analysis of propeller without fins are included in the table below. 

Same as thrust, the torque value from Standard Series Data is higher than torque of 

propeller without fins. The percent errors between the torque value from analysis of 

propeller without fins and Standard Series Data are also lower than 5%. Their average is 

approximately 2.6% 

 

Table 4.4: Comparison of torque from Standard Series Data  

against propeller without fins 

 

Velocity, 

Knots 

Torque from Standard 

Series Data, N 

Torque for propeller 

without fins, N 

Percent 

error, % 

3 13.5 13.2 2.4 

4 24.0 23.6 3.1 

5 37.5 36.5 2.1 

6 54.0 52.8 2.8 

7 73.5 72.3 2.4 

  Average 2.6 

 

The power provided by the engine is must be used to rotate the shaft connected 

between the engine and the propeller. Shaft horsepower is converted to a rotary force or 

moment applied to the propeller. This rotary force necessary to turn the shaft is simply 

torque.  

 

Figure 4.2 shows us the graph of torque versus rotational speed. We can see that 

this graph is almost similar to the graph of thrust versus rotational speed. Although their 

value was almost same at slower velocity, propeller without fins has a slight higher 

torque as the velocity increase. Overall, their trend is almost same and did not have any 

rapid changes. However the average torque produces by the propeller with fins are 

better than other propeller.  
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Figure 4.2: Graph of torque versus rotational speed 

 

  

 Table 4.5 shows us the percent increase value of torque between the propellers. 

Their trend is almost same as the table 4.3 because the percent increase value is not 

uniform. At 4 knots, the fins only increase 2.63% of the torque value. The percent 

increase is highest at 3 knots because the propeller with fins produces 5.1% higher value 

of torque compare to the propeller without fins at the same velocity. 
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Table 4.5: Comparison of torque value from propeller with and without fins 

 

Velocity, 

Knots 

Torque for propeller 

without fins, N 

Torque for propeller 

with fins, N 

Percent 

increase, % 

3 13.2 13.8 5.1 

4 23.6 24.3 2.6 

5 36.5 38.3 4.9 

6 52.8 55.4 5.0 

7 72.3 75.3 4.2 

  Average 4.4 
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4.4 ANALYSIS ON FLOW TRAJECTORIES 

 

 As previously discussed in Chapter 2, the increase of thrust can be explained by 

using blade element theory. It states that the thrust produce by the propeller are depends 

on the lift force act on the blade of propeller. These lift force is generated by the 

pressure difference between the back and front side of propeller. The back side is the 

side of propeller that faces the incoming fluid flow. It has higher velocity than the front 

side and hence the pressure here is lower. The difference of pressure between them 

dictate the lift force where higher pressure different will increase the lift force produced. 

 

Through analysis by CosmosFloWorks 2008, we can clearly observe the 

difference of flow velocity at the back side of blade propeller between the propeller with 

and without fins while the front side remains same. The figure 4.3 and 4.4 is a flow 

trajectories view from CosmosFloWorks 2008 at 5 knots on the back side of propeller 

blade. 

 

As we can see, the fluid flows from the inlet area near leading edge to the outlet 

area and the velocity increase through the surface of blade. The color tone bar shows 

that maximum velocity of flow on the surface of the propeller with fins is 11.4 m/s 

while the maximum velocity for propeller without fins is 10.6 m/s. Other than higher 

velocity, fins also make the flow lines close to each other. While the flow lines for 

propeller without fins spread to wider area. 

  

These faster flows will create higher pressure difference between the surfaces of 

the propeller blades and increase the thrust produce. Thus it is proved that the fins 

increase the performance of propeller in terms of thrust by manipulating the fluid flow 

on blade of propeller without any changes to the gear systems or engine. 
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Figure 4.3: Flow trajectories at the back side of propeller with fins 

 

 
 

Figure 4.4: Flow trajectories at the back side of propeller without fins 

 

 

 

 

  



 

 

 

CHAPTER 5 

 

 

CONCLUSIONS 

 

 

5.1 INTRODUCTION 

 

This analysis addressed the effect of fins to the performance of propeller in 

terms of thrust and torque. This chapter summarizes the important finding from the 

analysis carried out in this project. It is also includes some suggestions for the further 

work. 

 

 

5.2 CONCLUSIONS 

 

We can assume that the value of thrust and torque from the analysis using 

CosmosFloWorks is valid and acceptable because their difference from Standard Series 

Data of Wageningen B series propeller is less than 5%. The thrust value of propeller 

from Standard Series Data is higher than propeller without fins with average of 4.3% 

error and 2.6% error for the torque value. 

 

As the conclusion, the propeller with fins is better than propeller without fins 

because they produce higher value of thrust and torque. However, the percent increases 

are less than 10%, where the average increase of thrust value is 9.1% and 4.4% for 

torque. Higher value of thrust will increase the speed and acceleration of boat without 

any changes to the engine and gear system.  
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5.3 RECOMMENDATIONS 

 

The objective of this project to predict the performance of propeller is achieved, 

but it need further study using better software. Although it is more complex and need 

computer with high performance, FLUENT is the better software to analysis the 

performance of propeller compare to CosmosFloWorks. It is because FLUENT consider 

will more parameter and closer to actual condition. For further research, the 

experimental works under controlled laboratory conditions is important to determine the 

validation of the result from the software analysis. Other parameters like slippage, boat 

shape and engine capacity should be considered in the calculations. Also the scope of 

performance is widening to include vibrations, sound and cavitations. 
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APPENDIX A 

Standard Series Data for Wageningen B3.55 
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